
Norton CrashGuard™ 16-bit Crash Test dialog
Use this dialog box to generate any of the 16-bit exceptions listed. This will test the ability of CrashGuard™ to trap and fix the 
resulting crash.

To generate an exception:
1 Select the exception you want to generate.
2 Click Generate.

Note:
As you select each exception, a detailed description of it appears near the bottom of the dialog box.

{button ,KL(`Exceptions',0,`',`')} Related Topics



16-bit Exceptions
Norton CrashGuard™ traps crashes caused by the following 16-bit exceptions:

General Protection Fault
The program tried to examine data that is off-limits or does not exist.

Invalid Opcode
The program tried to execute an instruction that is not recognized by the processor.

Divide By Zero
The program tried to divide a number by 0.    This is an arithmetic problem for which there is no solution, so the computer can not
calculate the result.

Stack overflow
The program used too many automatic variables or nested function calls too deeply.

{button ,KL(`Exceptions',0,`',`')} Related Topics



Norton CrashGuard™ 32-bit Crash Test dialog
Use this dialog box to generate any of the 32-bit exceptions listed. This will test the ability of CrashGuard™ to trap and fix the 
resulting crash.

To generate an exception:
1 Select the exception you want to generate.
2 Click Generate.

Note:
As you select each exception, a detailed description of it appears near the bottom of the dialog box.

{button ,KL(`Exceptions',0,`',`')} Related Topics



32-bit Exceptions
Norton CrashGuard™ traps crashes caused by the following 32-bit exceptions:

Access Violation
The program tried to examine invalid data. This means that there is either no information at that location, or the information is 
off-limits to the program.

Array Bounds Exceeded
The program tried looking off the end of an array. In other words, the program looked off the end of a finite-sized table it has in 
memory.

Breakpoint
A breakpoint marks a place where the program should stop when being tested by the original programmer.

Datatype Misalignment
Some programs use datatype-alignment to ensure the program knows what type of data it is using. Such programs will stop with
this error if they try using the wrong type of data.

Float Denormal Operand
The program performed arithmetic using numbers too small to be represented in the normal way. Such numbers are called 
"denormalized" numbers.

Float Divide By Zero
The program tried to divide a real number by 0.    This is an arithmetic problem for which there is no solution, so the computer 
can not calculate the result.

Float Inexact Result
The program tried solving an arithmetic problem for which the result can not be precisely recorded using the computer's binary 
number system.

Float Invalid Operation
The program attempted invalid arithmetic, such as calculating the square root of -1 or dividing infinity by infinity.

Float Overflow
The program tried solving arithmetic which lead to numbers too large to be recorded in the computer's binary number system.

Float Stack Check
The program used up all of the math processor's internal storage space.    This error can also occur if a program tries to get 
more numbers from the math processor's storage after it has been emptied.

Float Underflow
The program performed arithmetic which yielded denormalized (too small to represent) results.

Illegal Instruction
The program sent the CPU an instruction which is undefined. This means the program uses a code number which does not 
correspond to any known operation.

In Page Error
(Simulated) This error occurs if Windows temporarily stores away some of a program's data on disk and then can not get it back 
when it is needed again.

Integer Divide By Zero
The program tried to divide the integer number 1 by 0.    This is an arithmetic problem for which there is no solution, so the 
computer can not calculate the result.

Integer Overflow
The program tried to solve arithmetic which lead to numbers too large to be recorded in the computer's binary number system.

Invalid Disposition
(Simulated) The program tried to solve another error for itself, but did not tell the system how it should then proceed.

Non-Continuable Exception
(Simulated) The program tried to continue after a serious error without fixing the problem which caused the error.

Privileged Instruction



The program tried to perform an operation which it does not have the right to do. For stability's sake, many important operations 
can only be performed by the system.

Single Step
Signaled the system that the program completed a single instruction. This will occur if the programmer forgot to remove 
commands he/she used to test a program.

Stack Overflow
The program used up all of the stack-type memory allotted to it. The stack refers to a program's short-term memory.

Unknown (or private)
The program generated an exception that is not a standard Windows exception.

{button ,KL(`Exceptions',0,`',`')} Related Topics



Answers to common questions
When does CrashGuard™ not catch a crash?

Although CrashGuard™ catches every type of crash, it can not catch all crashes that occur in KERNEL32.DLL, VXDs, and 
certain device drivers.

When does CrashGuard™ not fix a crash?
CrashGuard™ tries to fix every crash it intercepts, but it isn't always successful. Situations where a "recovery" may not be 
possible are:

the application crashes after it has corrupted its data
the application has entered a state and can not continue until the state is cleared
the application is 16-bit and has destroyed its stack

When does Anti-Freeze™ not work?
As when fixing 32-bit crashes, Anti-Freeze™ can not help an application if:

it froze after corrupting its own data
it is waiting for a state that was never cleared
it is a 16-bit application that stopped processing messages

How much memory does CrashGuard™ take?
CrashGuard™ is designed to be very transparent and lean:

The 32-bit exception handler takes no memory when "idle," and about 84K when handling a fault. 
The 16-bit exception handler uses 36K. 
The application associated with the icon in the clock area uses 36K. 
Grand total: 72K

How safe is CrashGuard™?
CrashGuard™ is extremely safe. 

As a "JIT (just-in-time) debugger," the 32-bit exception handler is only called when an exception occurs, so at worst, it can
only crash an already-crashed application. 

The 16-bit exception handler is also very safe in that it performs no background activity, does not hook, and does not 
subclass

it is only called by Toolhelp (part of Windows) when a crash occurs in a 16-bit application. 
The application associated with the icon in the clock area does nothing but bring up a menu when it is selected.

{button ,AL(`ConnectSymantec',0,`',`')} Related Topics



Anti-Freeze™
Anti-Freeze™ unfreezes a frozen application a program that was running and is still on your screen but is not responding to input 
from you or Windows.
When you notice that an application is frozen, launch Anti-Freeze™ and unfreeze the application.
To launch Anti-Freeze™:

Right-click the CrashGuard™ icon 

 in the clock area and select Anti-Freeze™.
or (if the CrashGuard™ icon is not visible),

Click Start, then Programs, Norton CrashGuard™, and Norton CrashGuard™. Click Anti-Freeze™.

{button ,EF(`crashgrd.hlp',`',5,`')} Help Contents



Clock Area
The recessed area at the right end of the Windows taskbar that normally displays a digital clock.



Closing CrashGuard™
To close CrashGuard™:

1 Right-click the CrashGuard™ icon  in the clock area.
2 Select Close. A dialog box will appear and ask you to confirm that you want to close CrashGuard™.
Notes:

Closing CrashGuard™ this way removes it from memory and prevents it from monitoring your system for crashes. (To 
restart CrashGuard™, see {button ,JI(`crashgrd.HLP>howto',`Launching_CrashGuard')} "Launching CrashGuard™.")

{button ,AL(`CrashGuardStates',0,`',`')} Related Topics



Closing a frozen application
Sometimes an application can not be satisfactorily unfrozen. (For example, an application may freeze because the data it is working 
with has been damaged. Anti-Freeze™ may unfreeze the application but then the application immediately freezes again because of 
the damaged data.) In such cases, you may need to close the frozen application.

To close a frozen application:
1 Close Anti-Freeze™ (if it is still open).
2 Press Ctrl+Alt+Del to display Windows' Close Program dialog box.
3 Select the frozen application in the list of running applications.
4 Click End Task.

{button ,AL(`AntiFreeze',0,`',`')} Related Topics



Configuring CrashGuard™
To configure CrashGuard™:

1 Right-click the CrashGuard™ icon  in the clock area.
2 Make sure 32-Bit Crash Protection is checked  to let CrashGuard™ trap and fix crashes caused by 32-bit applications.
3 Make sure 16-Bit Crash Protection is checked  to let CrashGuard™ trap and fix crashes caused by 16-bit applications.

These menu settings are toggles; select either menu item again to disable (remove the check mark from) the 
corresponding setting.
Note:

You can also configure CrashGuard™ by clicking Settings on the main CrashGuard™ shield.

{button ,KL(`Exceptions',0,`',`')} Related Topics



Norton CrashGuard™ Settings dialog
Use this dialog box to enable, disable, or test CrashGuard's 16-bit and 32-bit exception handler.

Crash Protection
Enable 32-bit Crash Protection Test
Enable 16-bit Crash Protection Test

Statistics
The text area displays the number of intercepted crashes and unfrozen applications.
Details

{button ,KL(`Exceptions',0,`',`')} Related Topics



Norton CrashGuard Statistics dialog
This dialog box displays:

how many crashes you have had
how many freezes you have had
which applications and modules caused the errors

Note:
The applications named TEST16.EXE and TEST32.EXE are CrashGuard's exception-generating programs that are run 

when you click Test in one of the Crash Test dialog boxes. If either application shows up in this list, those crashes were probably not 
encountered during "normal" computing.

{button ,KL(`exceptions',0,`',`')} Related Topics



Dealing with crashes
When CrashGuard™ traps a crash, the Norton CrashGuard dialog box appears and lists:

the program that crashed
the type of crash

To view details about the crash:
Click Details to expand the dialog box and display some detailed system information about the crash. (To save this 

detailed information to a text file, click Save and specify a name and location for the file.)
To fix a crashed application:

If the application that crashed was working with data that you need to save, click Fix to let CrashGuard™ try to fix the 
problem. You should then return to the application, save the data it was working with, and exit the application.
To close a crashed application:

If the application that crashed was not working with data that you need to save, click Close to close the application. Any 
data that the application was working with will be lost.

{button ,KL(`Exceptions',0,`',`')} Related Topics



Exception
A serious error which makes it impossible for a program to continue normally.



Frozen application
A software program that was running and is still on your screen, but does not respond to input from you or Windows.



Getting Technical Support and Information

To obtain the latest updates and patches for NORTON CrashGuard™:
Click LiveUpdate on the Norton CrashGuard™ shield. (See {button ,JI(`crashgrd.HLP>howto',`Updating_CrashGuard')} 

"Updating CrashGuard™.")
Visit the Symantec World Wide Web site at:

http://www.symantec.com
to obtain:

Technical Support
Answers to Frequently Asked Questions (FAQs)
Tips and Tricks

for NORTON CrashGuard™ and other Symantec products.
Click here 

 to connect to the Symantec Web site now!

{button ,AL(`ConnectSymantec',0,`',`')} Related Topics



NORTON CrashGuard™
CrashGuard™ runs in the background and monitors your system for crashes. It recovers from the crash and lets you save any 
unsaved data.
{button ,JI(`CrashGrd.HLP>howto',`Dealing_with_crashes')}    More

Anti-Freeze™
Anti-Freeze™ unfreezes a frozen application a program that is still on your screen but is not responding to input from you or 
Windows. When you notice that an application is frozen, you can pop up Anti-Freeze™ and unfreeze the application.

{button ,JI(`CrashGrd.HLP>howto',`Using_Anti_Freeze')}    More

Settings
Lets you select the types of crashes CrashGuard™ will intercept. You can choose to protect your PC from crashes caused by 
either 16-bit applications, 32-bit applications, or both. This option also lets you trigger any type of crash to test the ability of 
CrashGuard™ (or any other crash-protection program) to recover from the resulting crash.
{button ,JI(`CrashGrd.HLP>howto',`Configuring_CrashGuard')}    More

LiveUpdate
LiveUpdate connects you to the Symantec Internet site, downloads the latest CrashGuard™ updates and patches, and installs 
them on your PC. You must have a modem and/or an Internet connection (direct or dial-up) to use LiveUpdate.
{button ,JI(`CrashGrd.HLP>howto',`Updating_CrashGuard')}    More



Launching CrashGuard™
Installing CrashGuard™ sets it up to run every time you run Windows, providing you with constant protection from system crashes. 
CrashGuard™ is running if you can see the CrashGuard™ icon  in the clock area. If it is not running, you can launch it anytime.

To launch CrashGuard™:
Click Start, then Programs, Norton CrashGuard, and Norton CrashGuard™.

{button ,AL(`CrashGuardStates',0,`',`')} Related Topics



LiveUpdate
Connects you to the Symantec Internet site, downloads the latest CrashGuard™ updates and patches, and installs them on your 
PC. 

Note:
You must have a modem and/or an Internet connection (direct or dial-up) to use LiveUpdate.

{button ,EF(`crashgrd.hlp',`',5,`')} Help Contents



NORTON CrashGuard™
Like what you see?

If you have been happy with the protection that NORTON CrashGuard™ provides, check out these other great system-
protection products from Symantec Corporation:

Norton Utilities™
The expert's choice for solving all computer problems.

PC Handyman™
A friend who solves your computer problems.

Healthy PC™
The one-button checkup for your PC.

Norton AntiVirus™
Automatic virus protection that eliminates the threat of viruses from Internet downloads, floppy disks, email, shared files, 
networks, and hard disks.

For more information:
Visit the Symantec Web site at http://www.symantec.com
Connect to the Symantec Web Site now!

OR
Visit your local software retailer.



Recovering from crashes and freezes
When you use CrashGuard™ and Anti-Freeze™ to recover from crashes and freezes, you should not assume that everything is 
back to normal. The crash or freeze could be a symptom of more serious problems with the application. In general, you should:
1 save your work as best you can
2 exit the offending application
3 restart the application

Saving your work
Because your document or data file may have been damaged by the crash or freeze, you should first try to save your 

work into a new file using the Save As command (on the File menu of most applications). This way, the original file, which may still 
be sound, will remain intact.

If Save As will not work, try the Save command. But be aware that, even if the save seems to succeed, the next time you 
try to open the document, it may not open because of the possible damage, or it may need extensive repair.

If the Save or Save As commands do not work, try selecting the entire document (many applications have a Select All 
command on the Edit menu) and copying it to the clipboard with the Copy command (on the Edit menu of most applications). If you 
close the program and start it again (without shutting down Windows) you should be able to paste your work from the clipboard into 
a new blank work space.

Some programs include an Export command (often on the File or Tools menu), which may let you save your document in 
a different format. If an application has an Export command, it will likely have a corresponding Import command that you can use to 
reclaim your work after you exit the application.

If none of these techniques work, you can try printing your document or copying it down by hand so that you at least have 
a solid record of your work.
Partially disabled applications

Some freezes may be only partial; for example, the application may stop responding to the keyboard, but will still respond 
to the mouse. Try clicking the application’s menu, since that is the portion most likely to work and probably contains the commands 
you need most, such as Save, Copy, and Export.

After a freeze or crash, some parts of a program may stop responding while other parts still work. If the program was 
showing a dialog box at the time of the malfunction, try clicking its Cancel button or pressing Esc to make it go away. Do not click 
other controls unless you really need them, since they may be part of the malfunction.

Sometimes the shape of the mouse cursor can become frozen and its functionality will be other than what its shape 
indicates. If the mouse cursor is an hourglass (or some other special-purpose shape), try clicking the application anyway.

As you try to recover, some commands or controls may cause the program to crash or freeze. But CrashGuard™ and 
Anti-Freeze™ should catch those problems too, so just keep trying until you manage to save your work by one of the methods 
above.

{button ,AL(`AntiFreeze',0,`',`')} Related Topics



Settings
Lets you select the types of crashes CrashGuard™ will intercept. You can choose to protect your PC from crashes caused by either 
16-bit exceptions, 32-bit exceptions, or both. 
This option also lets you generate any type of exception to test the ability of CrashGuard™ (or any other crash-protection program) 
to recover from the resulting crash.

{button ,EF(`crashgrd.hlp',`',5,`')} Help Contents



Simulated exception
The CrashGuard™ Crash Test program will simulate this exception and not actually generate it.    Generating the exception either is 
not possible or would be too dangerous.



Testing CrashGuard™
You can use CrashGuard™ to generate 16-bit or 32-bit exceptions. This lets you test the ability of CrashGuard™ (or any other 
crash-protection software) to trap that type of crash and recover.

To test CrashGuard™:
1 Right-click the CrashGuard™ icon  in the clock area, then select Open. The CrashGuard™ shield will appear.
2 Click Settings. The Norton CrashGuard Settings dialog box will appear.
3 To generate either a 16-bit exception or a 32-bit exception, click the corresponding Test button. The Norton CrashGuard™
Crash Test dialog box appears.
4 Select the type of exception you want to generate.
5 Click Generate. (To recover, see {button ,JI(`crashgrd.HLP>howto',`Dealing_with_crashes')} "Dealing with crashes.")

{button ,KL(`Exceptions',0,`',`')} Related Topics



Uninstalling CrashGuard™
To uninstall CrashGuard™:
1 Click Start, then Settings, and Control Panel.
2 Double-click Add/Remove Programs.
3 In the list of installed software, double-click Norton CrashGuard™. Follow the instructions in the Norton CrashGuard™ Uninstall 

wizard.

Note:
This removes all Norton CrashGuard™ files from your hard drive. If you want to use CrashGuard™ again, you will need to

reinstall the software from the original disk(s).

{button ,AL(`CrashGuardStates',0,`',`')} Related Topics



Updating CrashGuard™
If you have a modem and/or an Internet connection (direct or dial-up), you can easily get the latest CrashGuard™ updates and 
patches using LiveUpdate.

To update CrashGuard™:
1 Click Start, then Programs, Norton CrashGuard™, and CrashGuard™.
2 Click LiveUpdate.
3 Follow the instruction on your screen.

{button ,AL(`ConnectSymantec',0,`',`')} Related Topics



Using Anti-Freeze™
When an application appears to be frozen:
1 Right-click the CrashGuard™ icon  in the clock area and select Anti-Freeze™. (See notes.)

The Anti-Freeze™ window will appear.
2 In the list of running applications, select the frozen application. (It will probably include "[Not responding]" in the label. See 

notes.)
3 Click Unfreeze to unfreeze the application so that you can save any unsaved data.

If this procedure does not unfreeze the application, see {button ,JI(`crashgrd.HLP>howto',`Closing_a_frozen_application')}
"Closing a frozen application."
Note:

If the CrashGuard™ icon is not visible in the clock area, you can launch Anti-Freeze™ by clicking Start, then Programs, 
Norton CrashGuard™, and Norton CrashGuard™. Then click Anti-Freeze™.

If none of the applications in the list include "[Not responding]," your application may not be frozen. You might want to 
close Anti-Freeze™ and wait a little longer to see if your application "comes back." 

{button ,AL(`AntiFreeze',0,`',`')} Related Topics



Viewing CrashGuard™ statistics
As CrashGuard™ traps crashes, it keeps track of:

how many crashes you have had
how many freezes you have had
which applications and modules caused them

To view these CrashGuard™ statistics:
1 Right-click the CrashGuard™ icon  in the clock area.
2 Select CrashGuard™ Statistics from the pop-up menu.
Note:

The applications named TEST16.EXE and TEST32.EXE are CrashGuard's exception-generating programs that are run 
when you click Test in one of the Crash Test dialog boxes. If either application shows up in this list, those crashes were probably not 
encountered during normal computing.



What is Anti-Freeze™?
Anti-Freeze™ is a program that can unfreeze a frozen application a program that was running and is still on your screen but is not 
responding to input from you or Windows.
When you notice that an application is frozen, you can pop up Anti-Freeze™ and unfreeze the application.

{button ,AL(`AntiFreeze',0,`',`')} Related Topics



What is LiveUpdate?
LiveUpdate connects you to the Symantec Internet site, downloads the latest CrashGuard™ updates and patches, and installs them
on your PC. 
You must have a modem and/or an Internet connection (direct or dial-up) to use LiveUpdate. 

{button ,AL(`ConnectSymantec',0,`',`')} Related Topics



What is a frozen application?
A frozen application is a software program that was running and is still on your screen, but does not respond to input from you or 
Windows. Use Anti-Freeze™ to unfreeze a frozen application.

{button ,KL(`frozen applications',1,`',`')} Related Topics



What is an exception?
The term "exception" refers to a serious error which makes it impossible for a program to continue normally. 

"Normal" errors
Many errors, such as trying to open a nonexistent file or save to a full floppy disk, are not exceptions because the program can 
simply tell you that a problem occurred and then continue. Even if a program asks the operating system to do something wrong, 
the operating system will tell the program that the action was not taken, and the program can continue.

Exceptions
An exception, on the other hand, would occur if a program tried to perform undefined instructions. The program could not 
continue because the operating system would not know where to find the next valid instruction in the program. Exceptions can 
result from many different malfunctions, but in every case, the computer does not know what to do next.

Handling exceptions
A program can try to handle exceptions for itself using its own exception-handling routine, which essentially tells Windows, "Here
are my instructions for dealing with an emergency." Even so, the program can only deal with those exceptions for which it was 
specifically prepared, and only if it knows how to resolve the problem.

Norton CrashGuard™ can protect your system against exceptions generated by 16-bit and 32-bit applications.

{button ,KL(`Exceptions',0,`',`')} Related Topics



Displays the 16-bit Crash Test dialog box from which you can generate 16-bit exceptions. This lets you test the ability of 
CrashGuard™ to trap and fix the resulting crash.



Displays the 32-bit Crash Test dialog box from which you can generate 32-bit exceptions. This lets you test the ability of 
CrashGuard™ to trap and fix the resulting crash.



Closes the dialog box without generating an exception.



Detailed CrashGuard™ statistics
This dialog box displays:

how many crashes you have had
how many freezes you have had
which applications and modules caused the errors

Note:
The applications named TEST16.EXE and TEST32.EXE are CrashGuard's exception-generating programs that are run 

when you click Test in one of the Crash Test dialog boxes. If either application shows up in this list, those crashes were probably not 
encountered during normal computing.



Displays detailed information about the crashes CrashGuard™ has trapped and the frozen applications it has unfrozen.



Displays the number of intercepted crashes and unfrozen applications.



Lets CrashGuard™ trap and fix crashes caused by 16-bit applications.
If you do not use any 16-bit applications (for example, older programs written for Window 3.x), you can leave this unchecked.



Lets CrashGuard™ trap and fix crashes caused by 32-bit applications.



Generates (or simulates) an exception of the type selected in the list above.
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